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About the Speakers

Mike is the AutoCAD Coordinator for Freese and Nichols Inc. (FNI), an engineering and architectural firm

located in Fort Worth, Texas. Certified in AutoCAD and AutoCAD Civil 3D software, he has over 35 years of
drafting and CAD experience. Michael draws from over 20 years of teaching experience to provide custom

material and training through Freese and Nichols University, the training arm of FNI.

Mark is the GIS coordinator for Freese and Nichols Inc. (FNI), an engineering and architectural firm
located in Fort Worth, Texas. An Esri Certified ArcGIS Desktop Professional and Esri Certified Enterprise
Assoclate, he has over 15 years of GIS and Database Experience.

Eddie is an ENI Technical Specialist for Construction Industry Solutions (COINS) in Dallas-Fort Worth. He
IS an Autodesk Certified Instructor, Certified Autodesk Product Support Specialist and Autodesk
Infrastructure Design Suite Certified BIM Specialist focusing on the products in the Infrastructure Design
Suite.
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Class summary

Today’s Class will address the age old questions of:

= “How do | add additional existing data to my design?”
= “Can | easily get this data into Civil 3D?”
= "How do | share my final design data for future projects®?”

The facts are:

= There Is a wealth of FREE data out there ready, willing and able
to be incorporated into your design workflow.

= We can be Takers and Givers of data.

= We face the need to utilize data from various formats
and providers, GIS data being one of the most important.

Today’s class is your Foundational Building Block for GIS-C AlE
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Goal: Use GIS Data for Preliminary Design and return
final design to GIS

Objectives
= Attach GIS data using Civil 3D
= Manipulate and Transform GIS data using Civil 3D
= Create Civil 3D design data directly from GIS data
= Export Civil 3D design back to a GIS database

GIS C3D SHP SDF
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ODbjectives
roLLOW THE GIS BRICK Roap

At the end of this class you will be able to: /A

ﬂ-

= Attach GIS data using Civil 3D
= Manipulate and Transform GIS data

using Civil 3D
= Create Civil 3D design data directly from
GIS data

= Export Civil 3D design to a GIS database

(©) MGM Studios — The Wizard of Oz

!}/Y AUTODESK UNIVERSITY 2014 A AUTODESK.



M AUTODESK UNIVERSITY 2014 A AUTODESK.



What i1s GIS?

= A Geographic Information System, or GIS, Is a computerized data
management system used to capture, store, manage, retrieve,
analyze, and display spatial information.

= Spatial data, also known as geospatial data, Is information about a
physical object that can be represented by numerical values in a
geographic coordinate system. Generally speaking, spatial data
represents the location, size and shape of an object on planet Earth
such as a building, lake, mountain or township.
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GIS First Steps
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GIS to CAD Workflow

= Set the Workspace (Planning and Analysis)
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Coordinate Systems

Meter International Foot
EPSG Code
1 1 TN/

State Plane _
Zone Northing Unit

Projected Easting
US Survey Foot Ground Latitude
Lonaitude

HAariznntal
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Coordinate Systems

= Know what your Coordinate
SyStem |S| A Coordinate System Library - O

H‘

Show
| If yO u d O n Ot kn OW A K Al Projected Geographic Arbitrary Datum Ellipsoid Geodetic Transformation Path Gecdetic Transformation
|
Status:| Up to date * | Code type:| Autodesk * | Category:| Mo filter selected > | Unit:| No filter selected

Someone
| T h e re are T h O u S an d S Of Status Code Description Definition type Referenced to Categories EPSG code Unit

idjan1987. idjan o Abidjan at Longs;lvory Coast;Af... 3 egree
(/] Abidjan1987.LL  Abidjan 1987 (G ' Abidjan1987 Lat Longs;von, f 414 Deg
d Iﬁe re nt ( :O O rd I n ate @  Abidjan1987T.. Abidjan 1987 / TM 5 NW P %) Abidjan1987  lvory Coast:Africa 2165 Meter
@  Abidjan1987.U... Abidjan 1987 / UTM zone 29N (P] W Abidjan1987  Ivory Coast:Africa 2043 Meter
S t (] Abidjan1987.U... Abidjan 1937 / UTM zone 30N (P] i Abidjan1987  vory Coast:ifrica 2041 Meter
CCra Gha... Accra ana Mational Gri W Acera Ghana:Africa 213 Go oast Foot
S el I IS (/] Accral929.Gh A S Gh Mational Grid P i Accral1929 h 2136 Id C
ccra . ccra o Accra at Longs;Ghana;Africa egree
@  Acoal929LL A G i Accral929  Lat Longs:G f 4168 Deg
] K O O a e a O O k (/] Accra1929.TM...  Accra/ TM 1T NW (P] i Accral929 Ghana:Africa 2137 Meter
NOW ur ar U WOIK In. o | . "
ﬂ AdamsWI-F Wisconsin Adams, US FT {or use... @ i HPGMN US4, Wisconsin - US Survey Foot
O AdamsWI-IF Wisconsin Adams, Int. FT [or use... @ LI HPGN USA, Wisconsin - International Foot
L U n d e rstan d I I I etad ata O AdamsWI-M Wisconsin Adams, Meter (or use... @ LI HPGN USA, Wisconsin - Meter
@  AdindanllL Adindan G Wi ADINDAN Lat Longs;Ethicpia;Suda.. 4201 Cegree
- 0 Adindan.UTM-... Adindan /UTM zone 35N @ L ADINDAN Ethiopia:Sudan:Africa 20135 Meter
= What the Unit :
a are e n I S O Adindan.UTM-... Adindan /UTM zone 360N @ L ADINDAN Ethiopia;Sudan;Africa 20136 Meter
O Adindan.UTM-... Adindan /UTM zone 37N EI i ADINDAN Ethiopia;Sudan;Africa 20137 Meter
@' Adindan.UTM-... Adindan /UTM zone 38N @ i ADINDAN Ethiopia;Sudan;Africa 20138 Meter

Manage Assign Vie Duplicate Edit - Close Delete Help
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Coordinate Systems - WKT

@ AUTODESK UNIVERSITY 2014

A

Coordinate System - TX83-NCF

Coordinate System
-Praojection

-Parameters

-WET

Datum

Ellipsoid

WKT

WEKT OGC:

PROJCS["TH83-NCF* GEOGCS["LLE3" DATUM["MADCE3" SPHERCID([*GR51980" 6373137.000,298.25722210] TOWGSSE4
[0.0000,0.0000,0,0000,0.000000,0,000000,0.000000,0.000000001], PRIMEM["Greenwich" 0], UNIT

[‘Degree” 0.017453292519043295]] PRCIECTION["Lambert_Conformal_Conic_25P"] PARAMETER

[*false_easting” 1968500.000] PARAMETER["false_northing” £6561666.667) PARAMETER

[“central_meridian® -98.50000000000000], PARAMETER[ |latitude_of_crigin® 31.66666666666670], PARAMETER
["standard_parallel_1",33.06666666660667] PARAMETER[ standard_parallel_2"32.13333333333333] UNIT

["Foet_US" 0.20430060060122]]

WET Oracle:

PROJCS["NADAE3Z / Texas Morth Central (ftlU5)",GEOGCS["NADE3" DATUM["Morth American Datum 1933 (EPSG 1D
6269)", SPHEROID["GRS 1980 (EPSG ID 7019)",6378137.000,298,25722210] TOWGS584
[0.0000,0.0000,0,0000,0.000000,0,000000,0.000000,0.000000001] PRIMEM["Greenwich" 0], UNIT[*Decimal
Degree®,0.017453292519943295]] PROJECTION["Lambert Conformal Conic"] PARAMETER
["False_Easting”,1968500.000] PARAMETER["False_Morthing” 6561666.667] PARAMETER

["Central_Merdian" -98.50000000000000], PARAMETER["Latitude_Of Origin" 31.66666666666670],PARAMETER
["5tandard_Parallel_1",33.966666666660667] PARAMETER["Standard_Parallel_2"32.133333323333333] UNIT["U.5.
Foot" 0.30420060060122]]

WEKT ESRI:

PROJCS["NAD_1983_StatePlane_Texas_Morth_Central_FIPS_4202_Feet® GEOGCS["GCS_Morth_American_1983" DATUM
["'D_Morth_American_1983" SPHEROID["GRS_1980" 6378137.000,298.25722210] TOWGS84
[0.0000,0.0000,0,0000,0.000000,0,000000,0.000000,0.000000001], PRIMEM["Greenwich" 0], UNIT

[‘Degree” 0.017453292519043295]] PROJECTION["Lambert_Conformal_Conic"], PARAMETER
["False_Easting”,1968500.000] PARAMETER["False_Morthing” 6561666.667] PARAMETER

["Central_Merdian" -98.50000000000000], PARAMETER["Latitude_Of Origin" 31.66666666666670],PARAMETER
["5tandard_Parallel_1",33.966666606666667] PARAMETER["Standard_Parallel_2"32.13333333333333] UNIT

["Foet_US" 0.20430060060122]]

Edit

Close

Help
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Data Types

= Databases :
. Data Connecticns by Provider @ Data Connect help

£ Add ArcSDE Connec tion 05Geo FDO Provider for SHP

= Requires Additional Configuration 2 s iy oo

e Add MySOL Connec tion o . . .

e _ Read/write access to spatial and attribute data in an
_@ Add ODEC Connec tion ESRI SHP file,

£ Add Oracle Connection
| R aSte rS £ Add PostgreSOL Connection
[E, Add Raster Image or Surface Connection

Bl Add SDF Connec tion

- JPG, SID, ECW, TIF, JP2 e
’ ) ) ) ¥ F/omeRmaEs £ Add 5QL Server Spatial Connection

B Add SOLite Connection
l'_fﬂ Add WFS Connec tion

| Web ConneCt|OnS @ Add WMS Connec tion

= GIS Files
= Shapefiles
= ArcSDE (at 10.3 Direct Connect Only)

= For complete list and configuration
requirements view the HELP!

Source file or folder:

E3 DATA CONNECT
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Styles and Labels

Stvle Thematic Rules

Labels
i 1ar\/

Style Editor . ~ Draw Order
Symbol  Size Font

Layer Files Line Thickness
' Line Cap
gra'e Color ‘=
Symbolizations

N

Haoiaht
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GIS to CAD Workflow —

= Open Style Editor

= Define Theme

= Define Labels

= Create Label Expression
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Styles and Labels

[?] Style Editor help

hh hm fﬂjl&gwl 'D?t?y-mc'l;t'-ﬁ_-- - I ldLlid] e o F I ] m l
Create /Modifu Fynreccinng

— — | @ Style and Label Editor

= i

=] . " .

5 Feature Text Label | Feature Svmbol Label
Property  Operator Mat e eature Symbo g

<];1 Eﬂ: — &M= /' Size context: (@ Device () Map
s
! Units: Paints W —
NAME|
| Symbeol and Style cﬂ: b4
J\
text
W
"
Text label text v
Ted Exp [NAME £ =
Fort Name Arial w | B
Font Size 11.3385826771654 w | B
BIUROG ~
y S~ 1=+ A~ B 1h A
I Rotation 0 degrees w | B v
= Validate £# Clear |[M Oy . m
Preview
Hel
tend =P
0K Cancel Help
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Demo
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Hands-On Activity

Create Base File from GIS Data

= Switch to Planning and Analysis Workspace

= Verify Coordinate System
= TX83-NCF State Plane Coordinate system

= Open Map Task Pane

= Attach SHP data from folder

= C:\Datasets\Hands-On Labs\GS5322-L Follow the GIS Brick
Road\Lesson 1\SHP

= Arrange Order of attached data
= Style and Label Data
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Benefits of Using GIS Data

= Readily Available Data

= Start Preliminary Design Sooner

= Extract GIS data for Preliminary Design
= Use contour data to create surfaces

= |dentify creeks, stream, rivers and lakes
= Locate roads and highways

= Locate Property Lines and ROW

!3/! AUTODESK UNIVERSITY 2014
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What GIS Resources are Avallable

GIS Resources
= http://www.esri.com/

= http://www.usgs.gov/

science for a changing world

= http://www.webgis.com/usgsseam.html

WEBGIS

= http://data.geocomm.com/ |

= Local Government Agencies p
0CO =

COCOMMUNITY

WWW.2eocomm.cond
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Surface Creation from GIS

'“'E'E"“:"-:-‘i?"ﬂ_v‘ﬁmm_

Home |Inset Annotate Modify Analyze

Creating Surface from SHP Workflow | *“**" sa LOIIRIUSERELENE EREE =

_ Qiect Qotior AR & Points - * I Feature Li
= Surface may be Created from Live Data comecrnoas [ AR 7 8" Grading -
= Attaching SHP Not Required iy PoIettes ™ AN Create Surtace
= Create Surface from GIS Data .ﬁ TA::SPAN: ‘— S

= Name and Style Surface
= Select Source Data Type
= Select Feature

= Define Area for Surface T Groups -2 bcreatesmacefromsradang
= Map GIS Data to Civil 3D Properties - 'ﬂ.bc,eate Surface from Corridor -

‘. Create Surface from TIN

I \
’ I W Create Surface from GIS Data

o
‘_% Create Cropped Surface
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Surface Creation from GIS

AUTODESK UNIVERSITY 2014
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Demo
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Hands-On Activity
Create Civil 3D Surface from GIS Data

1.

00 N o O s EaNIS

Open Drawing Lesson_ 2-1.dwg
MAPWSPACE>ON

Data Connect — Add SHP Connection
Attach Lesson 2/Contour_SHP/Contours
Create Surface from GIS Data

Use default settings for name and style
Select Area using Red Rectangle
MINORL1 — Elevation

Optional — Draw Line and Create Quick
Profile

AUTODESK UNIVERSITY 2014
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Existing Utilities From GIS

Creatlng Pipe Network from SHP | J
Attaching SHP Not Required ot Junc-idf‘
= At Least Two SHP — One for Pipes and One for Structures = 7

= Place SHP’s in single Folder

= [mport GIS Data

= Connect to Data

= Name and Style Pipe Network

= Map Features from GIS to Civil 3D
= |mport All or Some

= Connect the Dots

!}/IQ AUTODESK UNIVERSITY 2014

unc.shp

A_Import GIS Data - Pipe Networks - Clean Up

Connect to Data
V| Snap pipe and structure tolerance:  0.0015 feet

- < .
Object Options Discard unlinked pipes

Schema and Discard unlinked structures
Coordinates

Data Mapping: Pipes

Data Mapping:
Structures

Query Options

P Clean Up
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Hands-On Activity

Create Civil 3D Pipe Network from GIS Data

1. Open Drawing Lesson_2-2.dwg

2. Insert>Import>Import GIS Data

3. Connect to Data — Folder>Pipe Net_ SHP
4

. Name and Style Pipe Network
1. Parts List — Sanitary Sewer
2. Surface — FG Group
3. Structure Label Style — Standard
4. Pipe Label Style - Standard

Add Pipe:Circular |
Data Mapping:pipe_ssa.xml S

Add Junc:Cylindrical o=

Data Mappting:struc_ssa.xml ' i
Connect the Dots : .

e S |

_____

BRSOy
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Exporting Civil 3D Data to GIS
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Export Civil 3D Design Data to GIS

Each Completed Civil 3D Project Contains Valuable Shareable Information
Shareable Civil 3D Data: pr—

y N
A

//
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/
//V
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\
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|
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/

‘,/ e — —
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4 Y
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/4 g \\
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\
[J
/i \
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i I
| Parcels ,
\ |
\ /
‘:\ v //'
\‘\ «”
\
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3
>
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Export Civil 3D Design Data to GIS

How Do We Share Civil Data?

= Extract Contour Data (Civil 3D Surfaces)
= Export Civil Objects to SDF

= Maplmport / MapExport
= Bulk Copy

= GIS Export - Storm and

!}/'{ AUTODESK UNIVERSITY 2014

Cument drawing coordinate system

THAEI-NCF

MADS3 Texas State Planes, North Central Zo

Driver options

r -

Import properties for each layer imported:

Changing these options may affect t

Selection l Data ] Dptinns]

A e

—Ol'lfnll‘f Artnde<k R0 Heln Add-inc
E._<A“t°des“® Storm and Sanitary Analysis 2015 - Inlets FHWA - Initial State - [Plan View]

Stirvev Fynrecc Tonl<

File Edit Vi
NS EF aX (RS (%0, . WD ON<E@W /ebb-_ [/ (B [Aax ]

Plan View «

B Project Data N
~|&] Project Options

%, Analysis Options

4 -4 Hydrology -
[ Subbasins GIS Export - Step 1 of 4 X4
o ﬂ Rain Gages  §

4 ) Hydraulics I

4 ) Nodes

@ Junctions
4\ Storage Nodes

ew Input Design Analysis Output Window Help

Plan View

Welcome to the GIS
Export Wizard

This Export Wizard will step you through the
process of exporing node, link, and subbasin data from
Autodesk® Storm and Sanitary Analysis 2015
to external GIS shapefiles.

f
/
e e | Storage Curves |
[ Inlets {
4 -, Flow Diversion
Pk E} Flow Diversion Curves |

. o
i - Outfalls = ; u)j
2]

- M Outfall Tidal Curves
‘[ Extemal Inflows

4 Links
Input Layer Drawing Layer |I “ / Conveyance Links —
; " \ - @ Custom Plpe Geomelry To start, click on the Next buttan.
Alignments Alignments i Ng/ Imegular Cross Sections
Parcels Parcels 4@ Pumps
Pipes Pipes . i;l%ﬁ:::p Curves 7
Points Points L Weis Back Net> | | Cancel | Hep |
Structures Structures 4 Y= Outlets P - : = -
|/ Outlet Rating Curves 0%
4 Quality ‘ h <
Pollutants
i Pollutants Land Types
Saved profiles 4.5 Others

load... |

’ Save... ]

Cument profile:

4 188 Contal Bules

| SR

No Results -25844.68, 20904.40
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Export Civil 3D Design Data to GIS

Exporting Civil 3D Objects to SDF

« Length

= SDF - Autodesk file-based geospatial format that is optimized - Design Speed

« Starting Station

for storing large, classified data sets +Ending Station
= Unlike a Shape file, SDF stores both Spatial and Attribute data + Point Number

« Point Name

AutoCAD Civil 3D Object Exported Attributes

In a single file rather than a set of files
= 4 Types of Civil Data can be Exported to SDF e ettt -Pocs D
= Alignments e o dnate Syer
= Points ——— |
= Parcels

= Pipe Network Data

= Simply specify location of the SDF — Coordinate System in
drawing is assigned to SDF

= The GOOD: SDF Export is extremely EASY
The BAD: ESRI does not support the SDF Format e

= Where do we go from here?
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Export Civil 3D Design Datato GIS

Bulk Copy Using MAP 3D SDF

= Copy Data from one feature source to another, either inthe  gquree Data Store
same format or in a different one

= Upgrade from file-based (SDF or SHP) data storage to multi-

user database storage (Microsoft SQL Server, MySQL, or S

Oracle)
= Transform coordinate systems easily.

= Assign a coordinate system to a data store that does not
have one. Source ? LL-84

= Create a new data store whose coordinate system is @@@"di%%t L. - e,
different from the source.
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Export Civil 3D Design Data to GIS

Bulk Copy SDF to SHP Workflow

Data Connect to SDF File

Create Destination Folder in Windows Explorer for
Shapefile

Add Data Connection to this SHP Folder .

In MAP Task Pane select the Map Explorer Tab
= Notice the Connections listed

= Select Tools and Bulk Copy

Select the Source (SDF) and the Target (SHP)
Select the Items to Copy from Source SDF
Save Schema Mapping

=  SHP will not accept Items with Characters in the
name (Ex./,\, -, etc)

= Name Length must be 12 Characters or less
= Target Names can be shortened to avoid error
Click Copy Now — Shape files are created

!}}{ AUTODESK UNIVERSITY 2014

#& Bulk Copy =
From To
Source: SDF_1 Target: SHP_1
A Bulk Copy Wersion: \ersion:
From Select items to copy: Click on an item to select a different input name:
ures =DF_1 & | Alignments i1 <Choose Feature Class>
— =-m|f§ Parcels = Parcels
Version: [ ||| 7 5 21 Geometry - Geometry
Scectiensocopd|| | " |[@ Autogenerated_SDF_ID .. «Choose Propertys
— 1 e “2|[@] MName - Name
Bj% Civil_Sclf || & & 21 Area - Area
:lg Poimf | | 1 .. "2|[] Perimeter . Perimeter
:lrg' N =-m|F Pipes - Pipes
EIZIQ. FLE"": ----- T Geometry .. Geometry
:l"._. ----- " |[@ Autogenerated_SDF_ID . zChoose Property=
:l ----- Z1[@] Mame .. Name
:l ----- |[®] MetworkName - NetworkMame
:l ----- "#1[®] InsideDiameter ... InsideDiameter
S {1 I 1 A S " |[®] OutsideDiameter
£ Tl B e | al
-
Bulk Copy 22
I'f-. ffeature =
k. O TESEM.
QK
L
TS e rrorsmT
Schema Mapping D Insert errors
— Source coorminate system: TXEI-NCF
oad ... : .
Filter info: no filter =
Target coordinate system: [T] Unmatched data or geometric type
Schema Mapping
I Load ... ] I Save . Copy Mow l I Close ] ’ Help ]
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Hands-On Activity

./I ‘ I ~
| =

Bulk Copy SDF to SHP

1. Open Pipes and Parcels.dwg - , :
‘ SHX

2. In the Output Tab in the Ribbon select Export Civil Objects to SDF. "Pipes afid Parééigasdi

\\\\}

Verify location of SDF filename, Click OK. g |

3. In Home Tab in Ribbon, Palettes Panel, Expand and open Map
Task Pane. Select Data and Connect to Data.

Add SDF Connection (Pipes and Parcels.sdf)

Select Parcels, Pipes and Structures and Add to Map
Add SHP Connection to folder Bulk Copy to ESRI
Switch to Map Explorer Tab, Select Tools > Bulk Copy
Select From Source (SDF_1) and To Target (SHP_1)

Select the Items to Copy from Parcels, Pipes and Structures
= Deselect Autogenerated SDF _ID for all and OutsideDiameter
on Pipes
= Inthe Target Column under Pipes, rename InsideDiameter to
InsideDia and StructureStart to StructureS Shape Files

10.Click Copy Now and Continue Bulk Copy

Structures.dbf Structures.prj Structures.shp Structures.shx

L = OO =
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Export Civil 3D Design Datato GIS

Civil 3D Surface to Shape File Workflow

Extract Contour Data
Extracts Polylines at Elevation from Surface

Select one Major and Minor Contour. Right Click>Select Similar '

Right Click>lsolate Objects
MAPEXport

Savein:

Repeat AECSELECTSIMILAR g

Recent Input k
Isolate Objects k

Q < AUD... » Exportt.. Search Export to.

Organize ¥ Includein library v » = v 0 @

CIlpI:Jn:uard k

Selection Tab — Select Appropriate Object Type and
Export

Data Tab — Select Attributes, Expand Properties andjs
Desired Object Data

Surface is Exported as ESRI Shape file

bjects

Select:

Mame

[tODF'arce
DF‘ipes

Channel.cpg Channel.dbf Channel.idx

C

Channel.shp Channel.shx

File name:

Files of type®

')/k AUTODESK UNIVERSITY 2014
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Hands-On Activity

Export Civil 3D Surface to Shape File

1. Open Prop Channel.dwg

2. Select Surface. In the Surface Tools panel in the Ribbon Select
Extract Objects

3. Extract Major and Minor Contours from Civil 3D Surface

4. Select One Major and One Minor Contour, Right Click> Select
Similar > Right Click >Isolate Selected Objects

5. Type MapExport in command line. Name the file Channel and select
Files of Type to be ESRI Shapefile.

6. Select Line for Object Type and accept Select All for Objects to
Export

/. Inthe Data Tab, pick Select Attributes, Expand Properties, Select
Elevations and Layers as Properties to be Exported. @ﬂg D@ﬁ@

8. Click OK Twice. Open Shape file location and verify Creation of File

D Suiace
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Class Review

Lesson One

1. Where do we assign a Coordinate System for our drawing?
2. What are two Data Types that can be connected to?

Lesson

WO

1. What Data Field is critical for creation of a Surface from GIS?
2. When creating a Pipe Network from SHP, can you connect to a

single Shapefile or Folder of Shapefiles?

Lesson Three

1. What Civil 3D Objects can be exported to SDF?
2. What is the maximum Character length for SHP Features when

using Bulk Copy?
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Goal: Use GIS Data for Preliminary Design and return
final design to GIS

Objectives $
= Attach GIS data using Civil 3D \... \2
= Manipulate and Transform GIS data using Civil |
= Create Civil 3D design data directly fro

= Export Civil 3D design back to a GIS database /\/

Having Completed Today’s Session You: i
= Attached GIS data using Civil 3D
= Manipulated and Transformed GIS data using Civil 3D
= Created Civil 3D design data directly from GIS data
= Exported Civil 3D design back to a GIS database
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Session Feedback

* Via the Survey Stations, emaill or mobile device
= AU 2014 passes given out each day!

= Best to do It right after the session =
= |nstructors see results in real-time
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http://www.autodesk.com/creativecommons

| z S 2

Students, educators, and schools now have

~ FREE access to Autodesk design software &
.| apps.

Download at www.autodesk.com/education

hﬁ-' — =
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